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(Appendix — 11)

List of Common HTMIL Tags:

Tag Description

<l— For commenting out sections of HTML or placing comments within
HTML.

<!IDOCTYPE html>| Basically, DOCTYPE tells the browser what kind of document
we're loading. This tag tells the web browser that we are using
Version 5 of HTML

<a> It is anchor tag which is used to create hyperlinks in HTML.

<abhr> It is an abbreviation tag. It is used to define abbreviations, For
example: <abbr title="Cascading Style Sheeis">CSS</abbr>

<address> It is generally used o include Contact information for the author.

<area: This tag establishes areas in an image map. <area> is always used
inside of <map>

<article> The <article> tag is new in HTML3, This tag can be used to contain
blog entries, forum posts, ete.

<aside= New in HTMLS. The <aside> element 1s for making sidebars that
are placed next to the main content

<audio> New in HTMLS. The <audio> tag can be used to place an audio
stream within an HTML document

<b> It is used to bold the text

<base> It is used to set a base URL

<blockquote> It is used for quoting text from an external source. Typically
rendered as indented text

<body> It is used to define the body of the HTML. document

<br> It is used to insert a Single line break

<button> It specifies button that can be clicked. Commonly used with forms

<caplion> It is used to define the caption of table

<code> It is used to show the program code examples in the HTML
document

<datalist> New in HTMLS. Specifies predefined data for an <input>
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<dd> For description lists, Use with <dt> and <dl>

<del> Mark text as deleted without actually deleting it. This will typically
be rendered as a strikethrough

<div> Division or divider tag which is a kind of generic container

<dl> Definition or description list used with <dd> and <dt>

<dt> Definition or description Title used in the <dl> list

<em> It is emphasis tag which is used to emphasize text in bold format

<embed> New in HTMLS. It is a container for external content

<fieldset> It is used for Group related items in a form

<footer> The footer of a document, below the main content

<form= Forms for user input

<hl> Level 1 heading, the headline or title of a page

<h2> Level 2 heading, the subtitles of a page

<h3> Level 3 heading

<hd> Level 4 heading

<h5> Level 5 heading

<h6= Level 6 heading

<head> The head section. Used mostly for metadata

<header> Not to be confused with <head>, <header> typically contains
introductory content and layout that goes above the body

<hr> It renders as a horizontal line running across the page. This can be
used for separating text.

<html> The root level tag of an HTML document. All other HTML tags go
inside the HTML tag.

<i> It is used to make text italicized

<iframe> It is inline frame which makes it possible to embed another page
within a page. In HTMLS this 1s known as nested browsing.

<img=> For displaying images on a webpage.

<input> Input is used with various attributes to create form input elements.

<ins> Useful for denoting text that has been added to an HTML file since
the original version. Updates to a blog post for example.
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<khd> Used for keybaoard input.

<label> For assigning labels to interface elements such as forms.

<legend> Useful for making forms easier to understand,

<li> This represents a list item with an <ol> (ordered list) or <ul>
{(unordered list).

<link> Used for linking to external resources. Typically seen in <head>
referring to an external style sheet.

<main> New to HTMLS. These tags enclose the main content of an HTML
document,

<map:= Used when defining an image map.

<mark:> This is essentially used for highlighting.

<menus Used for creating various kinds of menus. This is new to HTML 5.1

<menuitem:s Specilies actions that can be taken with a menu.

<meta Used for specifying various meta information about the document.
Meta tags are used within the document <head=>.

<nav> Used for specifying a navigational region within a document.

<ohject> For embedding objects within a document.

<ol> Ordered list (1. 2. 3.). Used with list item <li>.

<option> Used within the <select= tag to specify an option

<p> It is used to define paragraphs

<pre=> For preformatted text, This can be useful for demonstrating code,
especially if there are multiple lines.

<q> Quote from some source.

<8 For marking up text that is no longer relevant, applicable, or
accurate.

<samp= Sample output one might get from a particular computer program.

<script= Seripts inside of an HTML document are enclosed in the script tags.

<section> A nonspecific means of breaking up content within a webpage into
sections.

<select> Used with <option> for selecting a particular option.
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<small>

Typically used for small print. Useful for comments within the main

content,

<source> Used with <audio> and <video= for specifying media source.

<span: Useful for applying styles to or around text, especially inline.

=sirong> The enclosed text is of strong importance

<style= For declaring style sheets within a document

<sub> For displayimg subscript. Useful for math, especially in conjunction
with <sup> (superscript).

<sup= For displaying superscript. Useful for math, especially in
conjunction with <sub> (subscript).

<table> For making tables in an HTML page.

<thody> Groups table rows.

<td> Table data; this represents a data cell within a table

<template> Declares HTML snippets that can be used later.

<textarea> For multi-line text entry.

<tfoot> Table footer.

<th> Table header cell.

<thead> Table header row

<time> Specifies the date/time within a document

<title> The title of an HTML document

<tr> A row within a table.

<track> Used to specify text tracks with <audio> and <video=.

<uz It 15 used to make text underhne

<ul> Unordered list. Use with <li> (list item) to make unordered lists

<var> Defines a variable within the content of an HTML page.

<video> For embedding video within an HTML page.
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@ppmdix Ill)
&9 magifedta s¥ HTML af$9 (Coding Solutions for Lab Activities)

waeifest 2.1
1. HTML 3% Ae-Ug'e & gen@er dfenr fea 2v Uw fana a9, fae fa 7ot 29-

gidwe f&g sawfenr fapar 71

2. fon 9 Uw & 75 o G787 959 Skyblue fZ 591

3

. EEI® & “projectd.himl” 57 &% A= g9 MT T9-Tw9 9 T9um & wileue &
=l

nigeifest 2.1 ¥t HTML &fdar;

<html>

</ html>

sheads

ctitle>Intreduction to HTML</LLlLlax
< fhesas
<body bgoolor="akyblus®>
<hl><lfonl colore"grean®>2_ 2 HIML/ [onls€ /1>
<p al lgn="justify”">HTHML was created by Tim Berners-Lee in 1991. There are lots of
version of HTML which are being developed. From an initial version of 1.0 to the
latest version of 5.2, HTML has developed a lot. W3C (World Wide Web Consortium) has
also maintained standards so that all browsers could have a common standard to
follow. HTMLS has developed a lot with new tags and the support of form elements.</pi-
<poalign="justify” >HTML stands for HyperText Markup Language. It is the standard
markup language for creating Web pages. A <tMarkup< /b language im a computer
language that uses tags (< ») to defipe elements within a document. These languages
are used by web browsers to manipulate text, images, and other contents of web pages,
in order to display them on the internat. It is not a case-sensitive langague.</[i»
< fhodys
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mazifest 2.2:

HTML ¥ He® Zam, fAast a9 wit fow us &9 greardt ofws a3t 9, ©f <93 999 0ot
fagr Sayq famwma a9

B g b - P

Govt. Sen. Sec. School

Welcome to my school..
Helle Everyone,

Iam a student of 10th class. I am studying in the Govt, Sen. Sec. School, My School is the most prestigious
schoal in the cily. My School is a two-storey elean and beawtiful building With Studics, other social snd cultursl
activities also happen in my school. There is also a big playground in which we play everyday. The clean and
pumsitivie atmosphere of our sehool mapires us Lo study_

School s U place where we lesrn Lo resd and wrlle, TL |a Lhe mosl erveclal place tor a
studont, and it help= vs to loarn new things. Tho toachors are always helpflul and teach us=
important things in Lite. We spust always be regolar Lo school a5 missing classes can lead ko
prublema during exams. Schools teach un how Lo be conaiatent and punctouml

maeifeet 2.2 ®¥ HTML 3fser:
him|>

head> <title>HTML Project i</ title> </head>
<body bgcol "pink® >
chl align="center"»Govt. Ben. Sec, School</hl
hrsdmargques>Welcoms to my achoal..</mardqueas <hes
<pb»<iHallo Bveryomne</i></b>,<br>
poalign="justify">T am a atudent of <b>10th clasa</b>. T am studying in the <font
fucee"Arial® colur="marcen®>Cnark>Govt. Ban. Sas. Bohoal</marks></font>. My Behoal

is the <u:most prestigious school in the city</u>. Hy School is a <u>two-storey
clean and beautiful buiiding:/u>. With Studies, other <ursocial and cultural
activitiesa:/u> also happen in my school. There is also a <bigsbig playground: /blos
in which we play everyday. The <u>ciean and positive atmosphere</u> of our school
inspires us to atudy.</po
cprittsBchoal is the place where wa learn to read and welte, It is the most crucial
place for a student, and it helps us to learn new things., The teachers are always
helpflul and teach us important things in life, We must always be reqular to school
as missing classes can lead to problems during exams. Schools teach us how to be
consistent and punctuslc/tts</p>
fbady>

fhtm] >
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maeifeet 3.1:
HTML & 293 gav o¢ ffg S9-Uw fove a9 & Jof S9-giwe &9 fous ngww
nrigeye yvafag ad|
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Compenenis of a Compuler System

Hiardwune
[Tiese are tee phivstcal compuosents of compuler svslen. We can (ouch tiese componsuts of compuler svslamn
Holboare
L hene are st of proprans Lo perfonm o Lesk in be compuier sysbem we can ool louch e compinemis of compules nysiem

Fa les of Mardware Comy is

I. Momimns
Kcyboard
P

Lk B
Yol
Frinier

B

niaeifest 3.1 st HITML &fdar:

<himl
TR
ctitleshimta in AL /tir =
< /neads
Chendyi>

sLlonl culur="oed"Cimponents 6f & Computer Hystem:/LonlsL/nis

cot rEardewara< il >
<ok Thess are the physlcal componsnts of compuber systen. We can fouch Ehese
omponents of computer syates. < il
tif -Bofbtwares il >
<xi*These are pet of programn to perfosm a task in the conpuber oyotom. we can
nok touch thess ooaponante of oonpubter syotan. s

wourRramples of Rardears Componsnbas o0 10

<1 i imitard/ | 1=

41 | sEeyhoard{ | i >
41 i viouaam< e
Dl Wl

1i>spaakar< /11>
<lisPrinters 11>

< f ol

dhi-n-Rxamples of Boftware: - /his

S
<livindowa 10</11>
<limME Painko/Iis
<1i-Wobtepad /11>
< 1iwordpad< /11
c1Li2M8 Word</li>
C11M8 Exeslcslin
c1ivMB PowerPeint</ 11

L/al>

o Mgy

£ihEmls
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mazifest 3.2:
J&T TOHTE WEHTY WIUST a%TH o e 288 fowBe met fig S 9uw 5 8:

| T b g wrt L = -

Time Table of 10th Class

1 U Bl Entriile o '8

Lect.No. || Subject I~ Teacher Name
1 [[wath {Mr. t1oney Kumar
2 | Mr. RBam Smgh

3 Fhwnpm:rﬁchmm Mre. (Chandona
|
4 HS'-“’“'-I Study hry, Minhedlhweari

5 Jliindi Miss Aruna Hatm
Rocess
il Ianjabi |[Mm. Gagandeep
7 English M. Johnn Smith
|G Flective Subject M. [Harbans Lal

Time Tahle for session 2021-22

niaeifedt 3.2 9t HTML afgar:

<hrtml>
<hasd>
<titlesTime Table Examplac/titles

</head>

-.I..n!..-.-

<hl zlign="center">Time Tabla of 10th Class</hl>

<hra

<table align="oanter" border="1" width="500">
<eaption allagn="bottom”">Tima Table for ssasion 2021-22</caption>
<tr bogcolor="yellow"><th>Laok. Hu.~ILh9m:h35ubjaatcftnv-thTaanhn: Name< /ths /L
atrs<td>l</tds<tel>Mathe/td><td>Mr. Honay Kumar</td></tr>
stre<td>2«</rdr<rdrBoiancecftd><cdsMr, Ram Bingh</td></tr>
ctrr<td=3</tdr<td>Computar Solence</tdr<td>Mrs. Chandana</tds</tr>
ctra<edsd</tdr<rd>Sanial Studyc/td><tdsMra, Mahsshwari</tds</tr>
ctrx<to>S</tdr<tdrHindi</td><td>Miss Axuna Batra</td>=</tr>
<tr bocolor="pink"><td align="ocsnter" colipan="3">Recsss</td></ers
ctrx<td=6c/tdx<td>Punjabl</td><td-Mre. Gagandesp/td></ tr>
aLi--:d»TnILd»-Ld-lngli;haqu--LdnH:, Johan Bmith</cds</tr>
atrx<tidsfdfrdr<tdsBlective Subject</cdx<td>Mr. Harbans Lal</td></tr>

</table>

= i --11..'.'-

</heml>
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niaetfEet 4.1:

Jat fer® waHe WuS Ags v = ¥ Ud f3wma @9 »3 feF & “myschool.html” &7 578 A=
&d |

o »
il il L =3 || -
- LTSN ] .

Govt. Sen. Sec. School

Webcouie 1o My Se

Schik] i the: plade whete we leam fo read nod weite, If id the sieal crocial place v student, and & Lelps w o leam eew things. The teschers afe alwayn
bipilial andd tench s emportanl thigs o |l W miaisi alwatyw bet régular lo schial ap mdsging clwses can lead b prohless during exams. Schoals feich o low

b b comtiment ail pumctunl
Lk _
. (i A1

TR
e AF g AR

[

Sly School bw ibe most prestigsoun schoal i she cxty. My Schonl o o twosioeey clean and besoidiel buddmg, Wigh Saches, other social and cubiurs| actvates
aksn happen inmy schoal. There i alw s hig ploygommd msdich we play everyrdny. The cless and podares atmogphere of por schood ingpires s io shody.

few =7 U f<9 27T Aaw ©f fewea © fan < =9eaaar 639 ©f =93 a9 Aew 01 HTML
Fgie (myschool.html) %3 ferw-eEl® (school.jpg) €= & feq mas 3 fw a €9 uw &
IASETT THS dd BE AEUT HIIH ©f <93 94 |

maetfeet 4.1 St HTML &fdar:

<html>
Lhaads dLLLILt-'I_'.F Sahosl< Eltles < Maads

whody >
<hl allogn="center":=Govwt. San. Seo. Sohool</hl>
chrr<marques>Welcome to My Bchool..</macguees> <ar>

fpoalian="justify"-Scghool is the place whars we lsarn to read and writa. It is tha
most crucial place for a student, and it halps us to lsarn new things. Tha tsachars
are always helpflul and teach uws important things in life. We must always be
regular to school as missing classas can lemad to problems during sxams. Schools
teach us how to be consistent and punctual</p-

coenter><imy border="1" src="./school.jpg"></center>

dp alian="qustify" My School is tha most prestigious school in ths aity. My School
iz a two-storey olean and bsautiful building. With Studies, othar sooial and
cultural activities alsec happen in my scheool. There 1s also a big playground in
which wa play everyday. The clean and pesitive atmespheare of our scheol inspires us
to mtudy.</p>

'._."I]_"L'I'.‘:E.'.'
</html >
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maretfeet 4.2:
foa 29 Ug 978 7 898 w2 JI8YS Ad3T 91 292 g9v J9F gy SQument 8w few@er 9=,
fre fa & fewrfenT famr @

] [F e e = 3| lms =

B i T b Mk b PR P

Some Useful Links for Students

My Schoal
Punjab School Lduesiion Board

ePunjzhSchond
Ashirwad Portal for Scholarships

J&T WEHg (Ean fanms a9

« My School & €7 Ba® @9 Ug &® 3 gd 7 WAt wiacifeet 4.1 few
{(*./myschool.html™) fanma &= A

« Punjab School Education Board & SWeT wifuarfaz SuATEe “hup://www.pseb.ac.in/”
&% fda 59|

« ePunjabSchool & §rel niftarfos Sanrete o= féa av|

 Ashirward Portal for Scholarships & §7et nifaarfas Sarrete
“http:ffscholarships.punjab.gov.in/” 7% féa &g

feq me féa @9 g879 ©f 551 v f&3 f&o uge 9vie os | Queas masifeet (madifeet

42) BEF HTML gz & 7 7 T “usefulsites.html” W &5 A= a9 f{E wrt

“myschol.htm!” FTgHe & A= &137 T|
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maelfeet 4.2 &t HTML &fEar:

<html] >

< href="https://www.epunjabscheol .gov.in/" target="_blank">ePunjabSchool
<farx<hr>
<a href="htip://scholarships.punjab. gev.in/" targot="_blank">Ashirwad
Portal for Scholarships</a><br>
< /body>

</html>

<head>» <title>Useful Sites</title> </head>

<bodys>

<hl align="center">Some Useful Links for Students</hl:>

<hr>

<a href=". /myschoel .html" target="_blank"*My School</a> <br>

<a href="http://wew.pseb.ac.in/" Larget="_blank">Punjak School Education
Board</a><br>

mazifest 4.3:

TaT fgF wizHg HTML - @99 & 293 gav J¢ feg “egr gon”’ 528

] Dritoate s iy bl 8 L
B Lywanan b i

Admission Form

Enter Shudant Name: | |
Enter Faiher Name: | ]
Seloct Gender: O Male O Femnle

Enter Address: v
Enter Contact Mumber: | |

Select Class: [Bh_ |
Select Elective Subjects: T Sansknt [ Agniculiure Ol Drawing O Plysicel Education

| Submit Dats || ResstFoem |
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maelfeet 4.3 &t HTML &f&ar:

<html>
<head>

<fhoad>
-'b-|_| rj ya

<hr>

Select Gender:

Enter Address:

Select Class: <

Select Elective

</ form>
</body>
</html>

<title>Admission Form</title>

<hl align="center"-Admission Form</h1:>

<form action="#" mathod="post">
Enter Student Name: <inpul Uype-"text"> <brx<br>
Enter Father Hame: <input typo="text"> <or-<brs

cinpul Lyps "radio" nane "gender”>Male
<input type="radie"™ namr="gender" Females <br><hr>

<lexlarez rows "2% cols "20"></lexlardas<br><hirs
Enter Contant Nomber: <input bypo=MtamtM> dbrednrs

acloct name="clagsg" >

<option valnc="6th">6th</options

suplion valuye "Teh »Tthe/upllons>

<pptiom wa iue="8th"»8th</ophion:

Zpplicn velye-"9th"s9th</opl lons

<gption value="10th">10the faptdons

<fsaleciy <brxchrs

Subjects: <input tipo="checkbox" namr="subject">Sanskrit
<input Lype="checkbox" name-"subject":>Agriculture

<input type=chackbox® namo="subject'>Drawing

cinput Lyps-="checkbox™ name-"subject">Physical Education
Zhr><hr>

cinput type="submit" valus="Snbmit Data™>
<input type="reset" valun="Ressat Form">
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(Appendix - 1V )

1. nigravt fee zréifuar Yafen st &v maeiieet

Exercise |

asdfe  :lkjh asdfg Jkjh asdfg Akjh asdfe Jdkjh asdfg
asdfg  :lkjh asdfg kjh asdfg Jkjh asdfg dkjh asdfg
asdfg  :lkjh asdfg Jkjh asdfg JAkih asdfg dkjh asdfg
asdfg  ;lkjh asdfa Jdkjh asdfg JAkjh asdfg Akjh asdfg
asdfg  :lkjh asdfg Akjh asdfg Jkjh asdfg dkjh asdfg
Exercise 11
Ask  Fad Alsas Shad Lads Flags Flask
Jag Fag Fall Hash Glad Galls Salad
Jak Had Gaff Dash Gall Flash Slash
Sad Lad Adds Lash Hall Lakhs Dhalls
Dad  Asks Alas Dall Fall Glass Shall
Exercise 111
qwert  poluy gwert poluy  gwert poiuy  qgwert  poiuy  qwert
poiuy  gwert poiuy  gwert  poiuy gwert  poiuy gwert  poiuy
gwert  poiuy gwerl  poiuy  gwerl poiuy  gwert  poiuy  gwerl
poiuy  gwert poiuy qwert  poiuy qwert  poiay  gqwert  poiuy
gwert  poiuy gwert poiuy  gwert poiuy  gwerl poiuy  gwert
poiny  gwert poiny  gwert  poiuy gwert  poiuy gwert  poiuy
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Exercise IV

awergfa olupj; awergfa ;olupj: awerqfa ;o1upj:
awergfa olupj; awergfa olupj: awerqfa ;oiup):
awergfa olupj; awergfa ;olupj: awerqfa :oiupj:
awerqfa olupj; awergfa ;olupj: awerqfa ;oiupj:
awergfa olupj; awerqfa ;olupj: awerqfa olup):
Exercise V
Fish Dirks Oldest Apple Grade Falls Kodak
Rails Jaded Dead Usual Sales Filed Legal
Lease Lakes Agile Isles Ahead Larks Roses
Forks Hedge Skill Rupee Grass Would  Alpine
Jaded Liked Equip Quail Jokes Asked Walks
Fiddle Saddle Dead Filed Lakes Lease Legal
Exercise VI
azxcvl lkmnbj azxevl Ikmnbyj azxevl Ikmnbj
azxevl lkmnby azxevl Ikmnby azxevl Ikmnbj
azxevl lkmnbj azxevl Ikmnbj azxevl lkmnbyj
azxcvl Ikmnbj azxevf Ikmnbj azxcvl Ikmnbj
azxcvl Ikmnbj azxevl Ikmnbyj azxcvfl Ikmnbj
Exercise VII
Cat  Jack Colour Neither Enemy Boat Caleutta
Not Have Jaints Calling Voted Very Vineyard
Met Wind Nerves Enlarge Money Move Material
Men Verb Verbal Someone Marry Give Sterling
Bent Joint Jackets Examine Thousand Cylinder Assessment
King Carry  Jumbled Examined  Struggle Possible Beginning
Zeal Night Booklet  Gracious Grizzled Frequent Meanings
Zero Tonic Cutting  Becoming  Zodiacal Exponent Doubtless
Exercise VIII
12345 (098767 12345 098767 12345 098767
12345 098767 12345 098767 12345 098767
12345 098767 12345 098767 12345 098767
12345 098767 12345 098767 12345 098767
12345 098767 12345 098767 12345 098767
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Exercise I'X

Type the following sentences 5 times:

I. Lost time is never regained

2. Get-up early and do your work

3. Today's youth and tomorrow’s old

4, Age is a virtue when wisdom is with it.

5. Measure your word before it goes out of you

6. My steps are measured

7. A friend in need is a friend indeed

8. Children are innocent and should be guided nghtly.
9. Our Land has great sages who knew the eternal truth.
10, Truth never fails

1 1. The Quick Brown Fox Jumps Over A Lazy Dog

Exercise X

Type the following paragraph 10 times:

Our flag is tri-colour. SAFFRON is the symbol of sacrifice and a string mind. WHITE is
the symbol of purity, love and peace. GREEN is the symbol of plenty and joy. We hoist and
salute our flag. We are ready to make sacrifices for our country, We want peace and
progress. We want to be pure.

L Y T
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2. UATHt (AnmolLipi) f€9 zfifar Uafen st 89 niaeifest

Home Row Exercise - |

Gresar ®aww  OFeswr ®awe  Geswr  maww OFeser mawo Beesar
Gresar  mawg Bresar  mawg  Gheswr  mawg  Onwswr mawg OWewer
Gresar  maEww Greswr mang OResar ®aww  GREsar  ®aww Gweswr
Gresar  ®awe  GAeser ®mawg EFEser ®aww  Gnwser  mawg Gweser
Gresar  maww Breser @ang OREsdr mawg GResdr  ®aAe BResw

Home Row Exercise - 11

Second Row Exercise-111
ITETT I ITEFTE g~ F_" ITETE X
FrETE 1 gt A ITEIZ TR D ITETZ i
grege v~ F_7 ITETT v~ F_ ITETT u- f_"
ITEIE g FE ITEIT A T ITETT w F
ITETE el A ITEIT i e ITETE g S
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Second Row Exercise-1V

gte_ 3 i gtG 3 g giG = gl S
gtg_& 22 s gtg_ & ol gtg_ 3z A2 ol
gt§¢ 5 g t_" gtg_ 5 il S gt v T 1. °
gt@ & 5 (i gt6_® i [0 gt _ = i [
g7 @& i (e gig_ 7 R g g _ & N
Home Row and Second Row Exercise-V
Greazg € A T miG gem T W
@reassl A miG gen i B & A
Greggg @ S T r - MG gew YW
Greaas A AT mig gew <
Greags@ T miG gEn =
Home Row and Second Row Exercise-VI
wffg ufgan "®TEAC nuuse wseve wBssn dTlx
Bfen sBeer usBe _nls wlmEm wfsse ==als
=meBre =8xeA n»ofee Teer woele =8wan AER
¥99F _TwOE  mAEfe®  _ _UEE wWIBRR T _me nmufse
sGeee  sfaze &3fu g8fs sSaER  niAgeT Bsan
gfeese nBovee gele  wfsee »Baen =e6re m=als
Home/Second/Third Row Exercise -VII
Gazees BAHSEA MATAEIT L A
Gaeasyd BAHEEA MATAESIT By " T9
@wzvgss BIHEEH HATHEFTT By Ty
CEELEF BIHSEH HATTEFTE By ¥y
Gazwey BFAHEEA MATHETE sy ¥y
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Fourth Row Exercise-VI1I1I

“12345 098767 *l#aw HE*()
12345 098767 1 #ay HE*()
12345 098767 *l #ax HE*()
12345 098767 lo#aw HE*( )
12345 098767 l o #aw HE*( )
Exercise - IX

mfen sy g BT feans
gfufeg CER:] AgS I e
C)iE AT g HEWS fagr
A&™ Ha&t gstarg fEstmr fafen
FIH fefgam gifes feam uATEr
faet Ty LECHS W CEGIC
gat=afnet At utg. H@H aEas Hateg
{HAd Guafear frmew fes Afge
THBIS! rCicy grer yHt HHE
dar gs Wy AT ferzsrat
firtus Ufemir fegmar i fsaem

Exercise - X

UATET GaTEaiAet UfesT € EiH A% 37. ARUS fiw € ferr fseemt w3 darst
fesm & it 4. su=t9 finy, 4. see= fing 9, 7. efEee i & nEremet 9
gufont gv. gAfEes fw 2 7. IgsHlE w & A-fsdlar s o siffar Argeane
fanrg atgr T fam ot et avaw T fewrer enga AT fieese 3 o9 AT <t
vt €9 feyer w93 Ayr T farr 31 88 39 fa gAT »ruet eh-hs =t mue fan
3T af aw € mas T Uat (9 39 rae 7| faffa feo meeene 306 Uamst
gatay &2 (T<t) [€F av a9s & rates Queay ae=€er |
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Acronym

(Appendix - V)

Mo S99 A€ @8 Y9 gu

Full Form

Al ARTIFICIAL INTELLIGENCE

ARPANET ADVANCED RESEARCH PROJECT AGENCY NETWORK
BMP BITMAP PICTURE

bpi BITS PER INCH

CD COMPACT DISK

CPU CENTRAL PROCESSING UNIT

CSS CASCADING STYLE SHEET

CUlI CHARACTER USER INTERFACE

DMP DOT MATRIX PRINTER

DOS DISK OPERATING SYSTEM

DRAM DYNAMIC RANDOM ACCESS MEMORY
DSL DIGITAL SUBSCRIBER LINE

DTP DESKTOP PUBLISHING

DVD DIGITAL VIDEO DISK

I COMMERCE

ELECTRONIC COMMERCE

EEPROM

ELECTRONICALLY ERASABLE PROGRAMMABLE
READ ONLY MEMROY

EMAIL ELECTRONIC MAIL

EPROM ERASABLE PROGRAMMABLE READ ONLY MEMROY
FTpP FILE TRANSFER PROTOCOL

GB GIGABYTE

GIF GRAPHICS INTERCHANGE FORMAT

GUI GRAPHICAL USER INTERFACE

HTML HYPER TEXT MARKUP LANGUAGE

IAP INTERNET ACCESS PROVIDER

IBM INTERNATIONAL BUSINESS MACHINE

1C INTEGRATED CIRCUIT

ISDN INTEGRATED SERVICES DIGITAL NETWORK
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ISP INTERNET SERVICE PROVIDER

IT INFORMATION TECHNOLOGY

JPEG JOINT PHOTOGRAPHIC EXPERTS GROUP
KRB KILOBYTE

MB MEGABYTE

MIDI MUSICAL INSTRUMENT DIGITAL IDENTIFIER
MODEM MODULATOR DEMODULATOR

MPEG MOVING PICTURE EXPERTS GROUP

MROM MASKED READ ONLY MEMROY

NIC NETWORK INTERFACE CARD

rB PETA BYTE

rC PERSONAL COMPUTER

PNG PORTABLE NETWORK GRAPHICS

Pop POST OFFICE PROTOCOL

PROM PROGRAMMABLE READ ONLY MEMROY
RAM RANDOM ACCESS MEMORY

ROM READ ONLY MEMORY

RTF RICH TEXT FORMAT

SERP SEARCH ENGINE RESULT PAGE

SMTP SIMPLE MAIL TRANSFER PROTOCOL

SRAM STATIC RANDOM ACCESS MEMORY

™ TERABYTE

TCP/AP TRANSMITION CONTROL PROTOCOL

LLSI ULTRA LARGE SCALE INTEGRATED CIRCUIT
] UNINTERRUPTED POWER SUPPLY

URL UNIFROM RESOURCE LOCATER

LUSB UNIVERSAL SERIAL BUS

VLSI VERY LARGE SCALE INTEGRATED CIRCUIT
WWWw WORLD WIDE WEB

WYSIWYG WHAT YOU SEE IS WHAT YOU GET
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WTH SIS e TTEMT Aase Jive
(MS WORD)

Shortcut Keys Used for
Cirl+A Select All
Cirl+-B Bold the selected text
Ctrl+C Copy the selected contents
Ctri+D Opens the Font Dialog Box
Cirl+E Center Align text
Ctrl+F Find text
Cirl+G Goto line/page no etc.
Ctri+H Replace text
Ctri+l Italic the selected text
Cirl+) Justify paragraph
Cirl+K Create Hyperlink for the selected text
Cirl+l. Left Align the paragraph
Ctri+M Increase Indent
Cirl+N Create a New File
Cirl+0O Open Existing File
Ctri+P Print File
Cirl+(Q) Clear Indents and Tabs
Cirl+R Right Align the text
Ctri+8 Save File
Ctrl+T Increase Hanging Indent
Ctrl+U Underline the selected contents
Cirl+V Paste the contents from the cliphoard
Cirl+W Close File
Cirl+X Cut the selected contents
Cirl+Y Redo the last action (if possible)
Ctri+Z Undo the last operation
Cirl+1 Single Line Spacing
Ctrl+2 Double Line Spacing
Cirl+5 1.5 Line Spacing
Cirl+| Increase Font Size
Cirl+] Decrease Font Size

Cirl+Shili+C

Copy the Formats of selected text

Cirl+Shifi+y

Paste the copied Formats on selected text

I3

Change Case

F7 Spelling and Grammar Check
Alt+F4 Close Program
=



(MS POWERPOINT)

 Shortcut Keys Used For
All + A Go to the Animations tab
Alt + F Open the File tab menu
Alt + F2or F12 Open the Save As dialog box
Alt + G Open the Design tab
Alt+H Go to the Home tab
All + K Go to the Transitions tab
Alt + N Open the Insert tab
Alt+Q Directs to the “Tell me what you want to do™ box
All+ R Go to the Review tab
Alt + 8 Go to the Slide Show tab
AlL + W Go to View tab
Alt + X Go to the Add-ins tab
Alt+Y Go to the Help tub
Alt or F10 Turn the Key tips to *on’ or “off’
Cirl + A Select all the objects on an active slide
Ctrl + Alt +V Open the Paste Special dialog box
Ctrl + B Togele bold on the selected text
Cirl + C Copy the selected text. object, or selected shide
Cirl + D Duplicate the selected object or a slide
Cirl + E Center align the selected text
Ctrl + F Search in a presentation or use Find and Replace
Ctrl + Fl Show or hide the ribbon
Cirl + F2 Print Preview View
Cirl +1 Togele italics on the selected text
Cirl + ] Justify the selected text
Cirl + K Insert a hyperlink
Ctrl + L. Lett align the contents
Cirl + M Insert a new slide

(MS POWERPOINT)
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Cirl+ N Create a new presentation

Cirl + O Open an existing presentation

Ctrl + P Annotate using a Pen tool while playing the slideshow
Ctrl +Q Save and close a presentation

Cirl + R Right align the selected text

Ctrl + 8§ Save a presentation

Cirl+T Display the Font dialog box after text or object 1s selected
Ctrl + U Add or remove underline to selected text

Ctrl + V Paste the selected text, object, or slide

Ctrl + W or Cirl + F4 | Close a presentation

Ctrl + X Cut the selected text, object, or slide

Cirl +Y Redo an action

Ctrl + Z Undo an action

Delete Delete the selected text. object. or slide

Esc End the slideshow

F5 Play the presentation from the start

F7 Check for spellings

Home Go back to the beginning of the shide

N or Page Down Move to the next slide while playing the slideshow
P or Page Up Return to the previous slide while playing the shdeshow
Shift + F5 Play the presentation from the current slide
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(MS EXCEL)
Shorteut Keys Used for
Cirl + A Select the entire worksheet. If the cursor is currently placed

within a table, preks once to select the table, press one more time to select the whole
worksheet.

Cirl+ B Bold Text of Selected Cell/Cells
Ctrl + C Copy the contents of the selected cells to Clipboard.
Cirl + DD Copy the contents and format of the first cell in the selected

range into the cells below. If more than one column is selected,
the contents of the topmost cell in each column will be copied

downwards.
Cirl + F Display the “Find” dialog box.
Ctrl + Fl Show / hide the Excel Ribbon.
Cirl + G Open the “Go to” dialog. Pressing F5 displays the same dialog.
Cirl + N Create a new workbook.
Ctrl + O Open an existing workbook.
Ctrl + I Open the “Print™ dialog.
Cirl + § Save the active workbook.
Ctrl + T “Convert selected cells to a table.
Cirl + ¥ Paste contents of the Clipboard into the selecied cell(s),
Cirl + W Close the active workbook.
Cirl + X Cut the contents of the selected cells to Cliphoard.
Cirl+Y Repeat (Redo) the last action, if possible,
Cirl+ Z Undo last action.
Ctrl + 1 Open the “Format Cells" dialog.
Ctrl + * Toggle hetween displaving cell values and formulas.
Cirl +; Enter the current date.
Ctrl + Shift + ; Enter the current time
F2 Edit the current cell.
F4 Cycle through various combinations of formula reference types.

Place the cursor within a cell and hit F4 to get the needed
reference type: absolute, relative or mixed

Fi2 Displays the Save as dialog box.

Home Return to the 1st cell of the current row in a worksheet.
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